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INTRODUCCIÓN A BLENDER

Blender es un programa de creación de contenido 3D, destinado a artistas, 
programadores y profesionales del sector multimedia bajo licencia GNU (Licencia 
Pública General) o GPL (General Public License). Esta licencia garantiza a los 
usuarios finales (personas, organizaciones, compañías) la libertad de usar, estudiar, 
compartir (copiar) y modificar el software con el propósito de declarar que es 
un software libre y así protegerlo de intentos de apropiación que restrinjan esas 
libertades a los usuarios.
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Actualmente Blender es uno de los programas con mayor número de 
usuarios en todo el mundo. La comunidad de usuarios es tan grande que existe una 
gran cantidad de sitios independientes, con diferentes idiomas y especializada en 
diferentes áreas. 

Una comunidad muy importante a tener en cuenta es la Fundación Blender. 
Aquí podrás ver el desarrollo de nuevos proyectos, descargar el programa en su 
última versión, discutir en el foro, aprender más sobre Blender y podrás ponerte en 
contacto con algunos desarrolladores de Blender si lo deseas.

1.1	 INTRODUCCIÓN

1.1.1	 La historia de Blender

En 1988 Ton Roosendaal cofundó el estudio de animación Holandés 
NeoGeo. Esta empresa se convirtió rápidamente en el estudio más grande de 
animación 3D en Holanda y en una de las más destacadas casas de animación en 
Europa. NeoGeo creó producciones, que fueron premiadas (European Corporate 
Video Awards de 1993 y 1995), para grandes clientes corporativos tales como la 
compañía multinacional de electrónica Philips. En NeoGeo, Ton fue el responsable 
tanto de la dirección artística como del desarrollo interno del software. Después de 
una cuidadosa deliberación Ton decidió que la actual herramienta 3D utilizada en el 
estudio de NeoGeo era demasiado vieja y voluminosa para mantener y actualizar y 
necesitaba ser reescrita desde el principio. En 1995 esta reescritura comenzó y estaba 
destinado a convertirse en el software de creación 3D que ahora conocemos como 
Blender. Mientras NeoGeo continuaba refinando y mejorando Blender, Ton se dio 
cuenta que Blender podría ser utilizado como una herramienta para otros artistas 
fuera del estudio NeoGeo. 

En 1998, Ton decidió crear una nueva compañía llamada Not a Number 
(NaN) derivada de NeoGeo para fomentar el mercado y desarrollar Blender. En la base 
de NaN estaba el deseo de crear y distribuir gratuitamente una suite de creación 3D 
compacta y multiplataforma. En ese momento, esto fue un concepto revolucionario 
ya que la mayoría de los programas comerciales de modelado costaban miles de 
dólares. NaN esperaba conseguir una herramienta de modelado y animación de un 
nivel profesional al alcance del público en general. El modelo de negocio de NaN 
consistía en proporcionar productos comerciales y servicios alrededor de Blender. En 
1999 NaN asistió a su primera conferencia en el Siggraph en un esfuerzo aún mayor 
para promocionar Blender. La primera convención del Siggraph para Blender en 
1999 fue un auténtico éxito y provocó un enorme interés tanto de la prensa como de 
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los asistentes a la convención. ¡Blender fue un gran éxito y se confirmó su tremendo 
potencial! 

En alas del gran éxito del Siggraph, a principios del año 2000 NaN consiguió 
una financiación de 4.5 millones de euros procedente de unos inversores. Este gran 
aporte de dinero permitió a NaN expandir rápidamente sus operaciones. Pronto NaN 
alardeó de tener más de 50 empleados trabajando alrededor del mundo intentando 
mejorar y promocionar Blender. En el verano del 2000, Blender 2.0 fue publicado. 
Esta versión de Blender integraba un motor de juegos a la suite 3D. Al final del 2000, 
el número de usuarios registrados en el sitio web de NaN sobrepasó los 250,000.

Desafortunadamente, las ambiciones y oportunidades de NaN no coincidieron 
con las capacidades de la compañía ni con la realidad del mercado de la época. Este 
sobredimensionamiento de la empresa condujo a una reestructuración creando una 
compañía (NaN) más pequeña y con nuevos fondos procedentes de los inversores. 
Seis meses más tarde, el primer producto comercial de NaN, Blender Publisher fue 
lanzado. Este producto fue dirigido al emergente mercado de medios interactivos en 
3D basados en entornos web. Debido a las decepcionantes ventas y al continuo clima 
de dificultades económicas, los nuevos inversores decidieron dar por terminadas las 
actividades de NaN. Esto también incluía parar el desarrollo de Blender. 

Si bien existían claramente defectos en la actual versión de Blender, con una 
arquitectura interna de software complejo, características inacabadas y un GUI no 
muy común, la magnífica ayuda de la comunidad y los clientes que habían comprado 
el Blender Publisher en el pasado provocó que Ton no pudiera permitir que Blender 
desapareciera en el olvido.

Como relanzar una nueva compañía con un equipo suficientemente grande 
de desarrolladores no era factible, en Marzo de 2002 Ton Roosendaal fundó la 
organización no lucrativa Blender Foundation (Fundación Blender) El primer 
objetivo de la Fundación Blender fue encontrar una manera de continuar el desarrollo 
y la promoción de Blender como un proyecto de Código Abierto basado en la 
comunidad de usuarios. En Julio de 2002, Ton logró obtener de los inversores de NaN 
un “sí” para que la Fundación Blender llevara a cabo su plan para que Blender fuera 
código abierto. La campaña de “Liberar a Blender” tenía que obtener 100,000 EUR 
para que la Fundación pudiese comprar los derechos del código fuente de Blender y 
los de propiedad intelectual a los inversores de NaN y posteriormente liberar Blender 
a la comunidad de código abierto. Con un entusiasta grupo de voluntarios, entre los 
que se encontraban varios exempleados de NaN, fue lanzada la campaña de “Liberar 
a Blender”. Para el deleite y la sorpresa de todo el mundo, la campaña alcanzó el 
objetivo de 100,000 EUR en tan solo 7 semanas. El domingo 13 de octubre de 2002, 
Blender fue liberado al mundo bajo los términos de la Licencia Pública General de 
GNU (GPL). El desarrollo de Blender continúa hasta nuestros días conducido por 
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un equipo de valientes y dedicados voluntarios procedentes de diversas partes del 
mundo y liderados por el creador de Blender, Ton Roosendaal.

1.1.2	 Blender y licencia GPL o GNU

El programa bajo licencia GPL (General Public License) puede ser usado 
por cualquiera, su finalidad es proteger los derechos de los usuarios finales (usar, 
compartir, estudiar, modificar). Respecto a otros programas que son comerciales 
usted tiene limitaciones, como por ejemplo la instalación en un número determinado 
de ordenadores, no puede hacer copias y mucho menos acceder al código fuente. 
Blender le da la libertad al usuario que otros programas no le permiten. 

	] Los derechos del usuario bajo licencia GNU (GPL)
	z Libertad para usar el programa 
	z Tener acceso al código y modificarlo. 
	z Puedes copiar y distribuir el programa.
	z En el caso de que realices mejoras en el programa puedes publicarlas.

También tienes algunas responsabilidades, que están diseñadas para proteger 
tu libertad y la libertad de otros, por lo que si distribuyes un programa GPL:

	] Debes proporcionar una copia de la GPL con el programa, así el usuario 
es consciente de los derechos que le otorga la licencia.

	] Debes incluir el código fuente o hacer que esté disponible gratuitamente.

	] Si modifica el código y distribuyes una versión modificada, dichas 
modificaciones deben estar licenciadas bajo la GPL y tienes que facilitar 
el código fuente modificado. (No puedes usar código GPL como parte de 
un programa propietario.)

	] No puedes licenciar el programa fuera de los términos de la licencia GPL. 
(No puedes transformar un programa GPL en un producto propietario).

1.1.3	 La comunidad de Blender 

Si piensas que por ser un programa libre no va a tener el mismo desarrollo 
que otro programa de pago estás muy equivocado. Una de las características que 
hace posible Blender es la comunidad de usuarios. Curiosamente se valora mucho 
la dedicación y el aporte de cada usuario, el ambiente es muy bueno y siempre 
encuentras a alguien que te hecha una mano, con tus dudas.
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En la página web blender.org encontrara todo lo necesario para descargar el 
programa y buscar toda la información que necesites. También puedes ver trabajos 
realizados con Blender o pedir ayuda en blenderartist.org.

Estas dos páginas son las principales pero Blender va más allá de estos dos 
sitios web, porque los usuarios de todo el mundo han creado blogs, foros y sitios web 
en distintos países y distintos idiomas. 

Esta gran comunidad le puede abrir puertas en todo el mundo y quien sabe 
puedes llegar a conocer gente que de otra manera te hubiera sido imposible. 

1.2	 INSTALACIÓN 

Para la instalación de Blender puedes descargar el programa desde la página 
web de la fundación www.blender.org. En esta página tienes que acceder al apartado 
de descargas Downloads. 

1.2.1	 Descarga y ejecución 

Selecciona el sistema operativo que utilizas y pulsa download. Puede 
encontrar la descarga de la última versión en Windows, Mac OSX, GNU/Linux. En 
este libro todos los ejercicios y las explicaciones están basados en la versión 2.73 y 
se trabaja sobre el sistema operativo Windows.

1.2.2	 Requerimientos del sistema

Blender usa OpenGL para dibujar toda la interfaz. Esto significa que es 
mejor si se utiliza una tarjeta gráfica que sea compatible con OpenGL. Blender se 
ejecuta en todas las tarjetas OpenGL-compatibles, aunque hay algunos problemas 
con las tarjetas de gráficos integrados (Intel, VIA). Por lo tanto, no se puede garantizar 
que Blender funcione bien en esos sistemas. 

1.2.2.1	 HARDWARE MÍNIMO 

	] De 32 bits de doble núcleo CPU 2 GHz con soporte SSE2. 
	] 2 GB de RAM 
	] 24 bits de 1280 x 768 
	] Ratón o trackpad 
	] Tarjeta gráfica compatible con OpenGL con 256 MB de RAM.
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1.2.2.2	 HARDWARE RECOMENDADO 

	] 64-bit CPU de cuatro núcleos 
	] 8 GB de RAM 
	] Pantalla Full HD con 24 bits de color 
	] Tres botón del ratón 
	] Tarjeta gráfica compatible con OpenGL, con 1 GB de RAM.

1.2.2.3	 HARDWARE ÓPTIMO (GRADO DE PRODUCCIÓN) 

	] 64 bits de ocho núcleos de CPU 
	] 16 GB de RAM 
	] Dos pantallas Full HD con 24 bits de color 
	] Tres botón del ratón y una tableta gráfica, 
	] Tarjetas gráficas OpenGL-compatibles duales, de calidad con 3 GB de 
RAM.

1.3	 LA INTERFAZ

Uno de los aspectos que menos gustan a la hora de trabajar con un programa 
es tener que ir buscando las herramientas que necesitas y no encontrarlas, por eso el 
objetivo del primer tema es explicar de manera práctica y visual como entender la 
interfaz de Blender.

Figura 1.1. Pantalla presentación
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1.3.1	 El teclado y el ratón

Un aspecto muy importante es que para trabajar correctamente tienes que 
tener la mano izquierda en el teclado y la derecha en el ratón. Si es la primera vez 
que utiliza un programa de diseño 3D te preguntaras ¿Para qué tengo que poner la 
mano en el teclado?

La razón es que la interfaz está diseñada especialmente para sacar el mayor 
rendimiento a la hora de trabajar. Primero hay que dejar claro que se trabaja con 
ratones de 3 botones o con ruedecilla en el medio y que Blender utiliza muchas 
combinaciones de teclado y ratón para tener un acceso más rápido a las herramientas.

Para no tener que ir escribiendo toda las teclas y botones, a continuación se 
especifica las abreviaturas que se van a utilizar en todas las explicaciones del libro.

Los botones del ratón se abrevian de la siguiente manera:

	] BIR (botón izquierdo del ratón)

	z BDR (botón derecho del ratón)

	z BCR (botón central del ratón)

Las combinaciones de teclado se abrevian de la siguiente manera:

	] TECL_G (cuando es una letra del teclado en concreto , en este caso la 
“G”)

	] SHIFT+C (cuando pulsamos la tecla Shift y la tecla “C” en este caso no 
se utiliza la abreviatura TECL)

	] SHIFT+CTRL+D (cuando pulsamos una combinación de 3 teclas )

	] NUM_5 (cuando nos referimos a los números del teclado numérico). Hay 
que prestar especial atención que este activado el NumLock del teclado.

	] ESC,TAB,F1 (cuando nos referimos a las teclas específicas que tienen 
todos los teclados)

	] File > Save (Cuando se le indique una ruta de acceso, es decir pulsar el 
botón File y acceder a la opción Save)

	] Para finalizar las teclas de dirección no se abreviaran sino que se utiliza 
el nombre completo y en mayúsculas ARRIBA, ABAJO, IZQUIERDA 
y DERECHA.
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1.3.2	 Entender la interfaz

La interfaz en si es un conjunto de ventanas distribuidas de un modo 
determinado en donde cada ventana contiene en su interior un apartado del programa 
con una serie de herramientas destinadas a realizar una función determinada. Es 
decir que si entiende el funcionamiento de las ventanas habrá conseguido entender 
cómo se organiza la interfaz de Blender.

Las características de estas ventanas son las siguientes:

	] No se superponen una a otra. Es decir si creas una nueva ventana, esta 
empujara a las otras para hacerse un lugar en la interfaz.

	] Todas tienen su propia cabecera. Es donde encontrarás las herramientas 
necesarias para cada objetivo.

	] Una ventana se puede subdividir en tantas como se desee o necesite.

	] Cada ventana puede ofrecer una función distinta.

Figura 1.2. Vista general de la interfaz
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1.3.3	 Las ventanas

Para identificar correctamente las partes de la interfaz se empezara por 
ver que es una ventana, y a continuación se mostraran los distintos elementos que 
podemos encontrar en ellas. Las ventana en sí, son un contenedor. Este contenedor 
tiene barras de herramientas y paneles con multitud de botones.

1.3.3.1	 PARTES DE UNA VENTANA

	] El área de trabajo: el área de trabajo es donde el usuario podrá modelar 
animar y en resumen ver las acciones que vaya realizando. Esta área 
de trabajo es una ventana llamada visor 3D. Existen muchos tipos de 
ventanas, que se explicaran más adelante.

Figura 1.3. Vista del área de trabajo

	] Los paneles: en el área de trabajo es muy probable que se encuentre 
con un panel en ambos lados. Estos paneles muestran herramientas y 
propiedades que le serán muy útiles a la hora de trabajar. Estos paneles 
pueden esconderse para garantizar más espacio de trabajo.

Para esconder estos paneles acerque el cursor donde limita con el área 
de trabajo y arrastre con el BIR hacia afuera y desaparecerá dejando le 
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una pequeña pestaña con el símbolo de suma. Si hace clic en el símbolo 
volverá a reaparecer el panel.

Figura 1.4. Paneles laterales

Otra forma mucho más cómoda y rápida es con las teclas de acceso 
rápido:

	● Panel izquierdo: pulsar TECL_T para esconder y mostrar el panel.

	● Panel derecho: pulsar la TECL_N para esconder y mostrar el panel.

	] El encabezado o barra de herramientas: la cabecera contiene todas 
las herramientas que necesitará para realizar el trabajo en función de la 
ventana en que se encuentre. Hago referencia a según qué ventana porque 
la cabecera puede variar. Normalmente se muestran en la parte inferior de 
la ventana, pero en otras es posible que las encuentre en la parte superior.

Figura 1.5. Barras de herramientas o cabeceras
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1.3.3.2	 TIPOS DE VENTANAS

Ahora que ya puedes identificar partes de una ventana, te resultara más fácil 
seguir las siguientes indicaciones. Para cambiar el tipo de ventana actual que es el 
visor 3D tiene que pulsar el primer botón de la barra de herramientas o cabecera de 
esta ventana.

Figura 1.6. Primer botón del encabezado del visor 3D

Se te desplegará un menú con muchas opciones, todas estas opciones son 
tipos de ventanas que te servirán para realizar distintas tareas. 

1.3.3.3	 TRABAJAR CON VENTANAS

En esta sección aprenderás cómo subdividir los visores y cómo fusionarlos 
para que puedas organizar el espacio de manera cómoda y sistemática. También 
aprenderás a escalar, intercambiar, maximizar y minimizar las ventanas. En un 
principio puede que cueste realizar alguna de las acciones, pero con la práctica 
llegará a ser una de tus acciones automatizadas.
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1.3.3.3.1	 Subdividir ventanas

Primero de todo tienes que identificar en la derecha superior del área de 
trabajo del visor 3D o en la parte izquierda inferior una forma triangular. 

Figura 1.7. Símbolos para subdividir ventanas

Selecciona el símbolo que se encuentra en la parte superior derecha y arrastra 
hacia la izquierda haciendo clic y manteniendo pulsado el BIR. Ahora realiza la misma 
acción pero esta vez arrastra hacia abajo, como se muestra en la siguiente imagen

Como verá, este proceso es muy sencillo y fácil de realizar. También podría 
realizar la misma acción arrastrando el símbolo de la parte inferior izquierda del 
mismo modo que se ha descrito anteriormente. En la siguiente sección se explica 
el proceso contrario: cómo fusionar las ventanas o visores que hemos creado 
anteriormente.
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Figura 1.8. Ventana subdividida

1.3.3.3.2	 Fusionar ventanas

Selecciona el símbolo que se encuentra en la parte superior derecha de 
una de las ventanas subdivididas y arrastra hacia arriba haciendo clic con el BIR y 
manteniéndolo pulsado como se muestra en la imagen. Sin dejar de pulsar el BIR 
verás que aparece una flecha sombreada de gran tamaño que le muestra la dirección 
en la que quieres fusionar la ventana.
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Figura 1.9. Ventana fusionada

1.3.3.3.3	 El menú Split Area

Es un menú que te permite realizar las acciones anteriores. Para acceder a 
este menú acerque el cursor del ratón a una esquina de la ventana, hasta que este 
cambie de flecha a doble flecha y pulse el BDR. En este menú puede seleccionar 
las opciones, Split Area y Join Area. La primera opción te permite subdividir las 
ventanas y la segunda opción mencionada anteriormente te permite fusionarlas.

Figura 1.10. Menú Split Area
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1.3.3.3.4	 Escalar ventanas

Para escalar una ventana deberás acercar el cursor a las líneas divisorias 
hasta que este cambie de flecha a doble flecha y arrastrar en la dirección que desees 
manteniendo el pulsando el BIR.

1.3.3.3.5	 Maximizar y minimizar ventanas

Cuando tengas cierto número de ventanas y requieras de más espacio para 
trabajar cómodamente puede maximizar tu ventana. En la cabecera de la ventana 
accede al menú View > Toggle Full Screen. También puedes realizar esta misma 
acción pulsando CTRL + ARRIBA. Cuando quieras volver al estado anterior realiza 
la misma acción pero pulsando CTRL + ABAJO.

Figura 1.11. Opción en el menú de la cabecera
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1.3.3.3.6	 Intercambiar ventanas

Siguiendo con el ejemplo anterior solamente tienes que arrastrar el símbolo 
que utilizabas para subdividir con la siguiente combinación de teclas CTRL + BIR. 
Automáticamente las ventanas se intercambiaran la posición.

Figura 1.12. Intercambio de ventana

1.3.3.3.7	 Ventana flotante

Para crear una ventana flotante accede al menú View > Duplicate Area 
Into New Window de la cabecera de la ventana. Para realizar esta acción mediante 
combinación de teclas es el mismo procedimiento que cuando intercambiamos 
ventanas pero pulsando las siguientes combinaciones de teclas SHIFT + BIR. 
Automáticamente surgirá una copia en forma de ventana flotante que te permite 
trabajar desde fuera de la interfaz.
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Figura 1.13. Ventana flotante

1.3.4	 Interfaz por defecto

Existen menús, paneles, pestañas�etc. Para que las siguientes tareas sean más 
fáciles de explicar a continuación se hace un resumen de los elementos que podemos 
encontrar en la interfaz por defecto.

1.3.4.1	 EL ENCABEZADO PRINCIPAL

Esta barra de herramientas está compuesta por los siguientes elementos:

	] Botones menú: estos botones son los que encontrarás en todos los 
programas. En esta versión 2.71, solamente tiene File, Render, Window, 
Help.

Figura 1.14. Menús
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	] Selector de pantalla: puedes cambiar el perfil de la interfaz según el 
trabajo que desees realizar. Por ejemplo si quieres animar un personaje 
puedes seleccionar la opción Animation y la interfaz se distribuirá con 
las herramientas más adecuadas para animar. 

	] Selector de escenas: en Blender es posible tener varias escenas en un 
mismo archivo. Puedes elegir entre distintas formas para crear nuevas 
escenas. 

	] Selector de motor de render: en Blender tiene tres motores de renderizado. 
En este libro se explica el funcionamiento de Blender Render y del Cicles 
render.

Figura 1.15. Opciones de motores de render

	] Texto informativo: el texto que se encuentra a continuación te da 
información de la versión que está utilizando, el número de vértices, 
caras y triángulos del objeto que tenga seleccionado. En resumen te da 
información de la escena. 

Figura 1.16. Texto informativo

1.3.4.2	 EL OUTLINER

Esta ventana es una de las importantes, porque da información de los objetos 
que tenemos en la escena y también te permite manipular ciertos aspectos de los 
objetos. El outliner está compuesto por los siguientes elementos a parte de los que 
se han nombrado anteriormente.
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	] Caja de textos: esta caja que se encuentra en el encabezado permite hacer 
una búsqueda de un objeto en concreto.

	] Selector de filtro: permite restringir lo que se muestra en la lista inferior. 
Por defecto está en All Scenes.

	] Botones de restricción: estos botones activan y desactivan una función. 
El ojo esconde el objeto de la escena, el cursor hace que el objeto sea 
seleccionable o no y la cámara de fotos hace que el objeto sea renderizable 
o no.

	] Iconos objetos: los objetos dependiendo de la función que desempeñan 
se les otorga un icono representativo.

Figura 1.17. Ventana outliner

1.3.4.3	 PROPIEDADES

Esta ventana contiene todos los tipos de botones que podemos encontrar en 
Blender. Este apartado es muy importante porque contiene todas las propiedades 
que necesitarás para trabajar, como por ejemplo la configuración de materiales, 
modificadores partículas etc... Para organizar correctamente toda esta información 
se agrupan en botones representados por un gráfico.

Figura 1.18. Imagen de la barra de propiedades



32    IFCT157 - DISEÑO TRIDIMENSIONAL CON BLENDER	 © RA-MA

Cada botón contiene un panel con un conjunto de herramientas o contexto, 
es decir cuando pulsamos un botón en concreto este nos muestra un panel con todas 
las propiedades necesarias para trabajar un aspecto en concreto.

Figura 1.19. El panel del botón objeto

Dentro de estos paneles tenemos distintas secciones agrupadas dentro 
de una tabla que se pueden extender o colapsar para ganar espacio. También una 
característica es que podemos cambiar el orden de las tablas arrastrando con el BIR.

Un aspecto importante a tener en cuenta es que los botones de propiedades 
se organizan jerárquicamente como se muestra a continuación:

	] Renderizar: contiene todas la propiedades del renderizado.

	● Render Layer: contiene propiedades para organizar el renderizado.

	] Escena: contiene aspectos generales de la escena, como las unidades, la 
gravedad de la escena etc…

	● World: contiene los aspectos necesarios para crear ambientes cómo 
cambiar el color del cielo, mejorar la iluminación.
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	● Objeto: contiene las propiedades de visualización, transformación, 
visibilidad, duplicación e información de animación, siempre respecto 
a los objetos.

	– Restricciones: propiedades para controlar aspectos de los objetos.

	– Modificaciones: en este apartado disponemos de multitud de 
operaciones que afectan al objeto de manera no destructiva como 
alterar la geometría o crear una simetría.

	– Datos de objetos: en este apartado se encuentran todos los datos 
que tienen nuestros objetos.

	– Materiales: es donde podrás crear materiales.

Texturas: esta especialmente vinculado al material y nos proporcionará 
herramientas para añadir detalles a los materiales.

	– Partículas: contiene todas la propiedades para crear objetos como 
pelo, césped o fuegos artificiales.

	– Físicas: este apartado contiene propiedades relacionadas con la 
simulación de telas, campos de fuerza, fluidos, humos etc�

Dentro de cada contexto o panel encontraremos muchos tipos de botones o 
controladores de propiedades.

1.3.4.4	 TIMELINE

Esta ventana te permite tener control del tiempo en tus animaciones, también 
podrás crear fotogramas clave y copiarlos pegarlos etc… Se explicará con más 
detalle en el capítulo de animación.

Figura 1.20. La ventana Timeline

1.3.4.5	 3DVIEW

Es la ventana que vas a utilizar más. En los próximos capítulos se explicará 
con más detalle aspectos concretos como el modelado, a continuación se detallan 
aspectos generales de los paneles izquierdos y derecho de esta ventana.
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Panel Izquierdo: este panel contiene las herramientas agrupadas en pestañas 
para poder crear objetos y modelarlos. Este panel puede variar según el modo en que 
se trabaja. Por defecto encontramos las siguientes pestañas.

	] Tools: encontrarás herramientas de transformación, duplicar, borrar, el 
historial, suavizado� etc.

	] Create: en esta pestaña podrás crear los distintos objetos de que dispone 
Blender.

	] Relations: las siguientes herramientas se utilizan para crear grupos o 
enlazar características entre objetos.

	] Animation: contiene herramientas relacionadas con la animación, se 
verán en detalle en el capítulo correspondiente.

	] Physics: contiene herramientas relacionadas con aspectos de la física.
	] Grease Pencil: es una herramienta muy útil que te permite dibujar encima 
de la ventana.

Figura 1.21. Panel Izquierdo
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Panel derecho: este panel a diferencia del anterior contiene diversas 
propiedades que facilitaran la manipulación de objetos en el visor y el aspecto del 
visor. A diferencia del panel derecho este no varía según el modo en que se trabaje, 
pero si varía según el tipo de ventana que utilicemos. Por defecto encontraremos las 
siguientes propiedades:

	] Transform: te permiten desplazar, rotar y 
escalar los objetos que tengas seleccionados 
en los ejes x, y , z mediante la introducción 
de valores concretos. También puedes 
dimensionar el objeto

	] Grease Pencil: crea nuevas capas para los 
dibujos que hagas con esta herramienta, 
mencionada anteriormente.

	] View: te muestra diferentes propiedades de 
navegación en la ventana o visor.

	] 3D Cursor: contiene propiedades de 
posición de este elemento el cursor 3D. Se 
explicará más adelante este elemento.

	] Items: sirve para que pongas nombre al 
objeto que tengas seleccionado en ese 
momento.

	] Display: contiene propiedades de como se 
muestran los objetos en la ventana

	] Shading: propiedades del sombreado de los 
objetos

	] Motion tracking: propiedades de la cámara.

	] Background Images: puedes añadir 
imágenes como fondo.

	] Transform Orientations: te permite 
seleccionar o añadir que tipo de orientación 
quieres utilizar para las transformaciones.

Figura 1.22. Panel derecho
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	L NOTA
No pretendas memorizar ninguna de estas opciones porque la intención es de que 
tengas una idea general de cómo se organiza la interfaz de Blender por defecto.

1.3.5	 Botones y controladores

Los botones y los controladores es un tema que por intuición, suele entenderse 
sin problema. A continuación se te mostrarán los distintos tipos de controladores que 
encontrara en Blender.

	] Botón de operación: al pulsar un botón de operación este ejecuta la 
operación.

Figura 1.23. Botón de operación

	] Botones de conmutación: son botones que disponen de dos estados 
activado o desactivado. Cuando están activados se muestran con una 
marca dentro del cuadro.

Figura 1.24. Botón de conmutación
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	] Botones de radio: es un botón conmutador asociado a otros botones 
en un mismo contexto. Cuando se activa uno los demás permanecen 
desactivados.

Figura 1.25. Botones de radio

	] Botones numéricos: los controladores que tiene botones numéricos 
suelen contener en su interior un valor o porcentaje. Para cambiar estos 
valores puedes utilizar las flechas laterales en el caso de que las halla, 
arrastrando con el BIR a la izquierda o a la derecha o también puedes 
hacer clic en el centro del botón pulsando CTRL+BIR, para introducir 
el valor manualmente.

Figura 1.26. Botones numéricos

	] Botones de menú: los botones de menú te muestran un submenú en 
forma de lista con distintas opciones.

Figura 1.27. Botón menú

	] Selector de color: cuando haga clic con el BIR encima de él, aparecerá 
un panel de diálogo con una muestra de colores donde podrás seleccionar 
o introducir los valores del color que necesites.
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Figura 1.28. Selector de color

	] Cuentagotas: en el selector de color también encontrarás un botón 
llamado cuentagotas, que te permite copiar el color de un objeto en 
particular, sin necesidad de introducir ningún valor. 

Figura 1.29. Botón cuentagotas

1.3.6	 Navegar por el espacio 3D

Principalmente debes de asegurarte de que el cursor del ratón se encuentra 
dentro del espacio de trabajo del visor 3D. Te puedes mover por todos los ejes de 
coordenadas de 3 maneras distintas:

	] Rotar por el espacio: mantener pulsado el BCR y arrastrar en la dirección 
que desees. Tendrás la sensación de que estás girando alrededor de los 
objetos que se encuentran por defecto en el centro de la escena.
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Figura 1.30. Rotar

	] Moverse por el espacio: mantener pulsado el BCR + SHIFT y arrastrar 
en la dirección que desees. Verás cómo el visor se mueve de un lado a 
otro de manera que siempre se mueve desde un eje determinado.

Figura 1.31. Desplazarse

	] Zoom: puedes hacer zoom moviendo la rueda del ratón. Si la mueves 
hacia adelante el zoom realiza la acción de acercarse y si la rueda la 
haces girar hacia detrás el zoom realiza la acción de alejarse. También 
puede utilizar la combinación de teclas Ctrl + BCR (botón central ratón) 
y arrastrando hacia arriba el zoom te acercará y si arrastras el ratón hacia 
atrás el zoom le alejará.
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Figura 1.32. Acercarse alejarse

	L NOTA
En ocasiones es posible que sin querer te alejes demasiado de los objetos y te pierdas 
en la inmensidad del espacio 3D, una forma rápida de volver a situar la vista como 
estaba es pulsando CTRL + C.

1.3.6.1	 PROYECCIÓN PERSPECTIVA Y ORTOGRÁFICA

La perspectiva es el arte de dibujar para recrear la profundidad y la posición 
relativa de los objetos comunes. En el visor perspectiva, se simula la profundidad y 
los efectos de reducción de los objetos.

Figura 1.33. Imagen de la Izquierda en modo Perspectiva y en la derecha Ortográfica
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La vista ortográfica es un modo de visualización muy utilizado en la industria 
de la arquitectura porque los objetos se muestran en la misma proporción. Es decir 
si pusiéramos varios objetos en paralelo al plano de la imagen, tendrían el tamaño 
real, en proporción forma y configuración. Es una de las vistas más utilizadas para 
realizar planos en AutoCAD.

Figura 1.34. Menú con las opciones Persp/Ortho

Para cambiar de proyección perspectiva a Ortográfica puedes acceder al 
menú View > View Persp/Ortho. También puedes pulsar el NUM_5 del teclado 
numérico. Realizar la misma acción para volver al anterior.
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1.3.6.2	 LAS PROYECCIONES DEL TECLADO NUMÉRICO

Una de las opciones que debes tener en cuenta por la rapidez y comodidad, 
es el cambio de proyección del visor; Frontal, Trasera, Izquierda, Derecha, Superior, 
Inferior.

Parece complicado pero es muy sencillo. A continuación se te mostrará una 
imagen de un teclado numérico y qué acciones llevan a cabo cada una.

Figura 1.35. Teclado numérico

1.	 NUM_5: permite cambiar de Perspectiva a Ortográfica.

2.	 Si te fijas verás que debajo de estos números (8, 4, 6, 2) tienen una flecha 
de dirección, estas teclas realizan la acción de estas flechas de forma 
que si pulsa el número cuatro verá como el visor se desplaza hacia la 
izquierda.

	● NUM_8: rotación hacia Arriba.

	● Ctrl + NUM_8: desplazarse hacia Arriba.

	● NUM_4: rotación hacia la Izquierda.
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	● Ctrl + NUM_4: desplazarse hacia la Izquierda.

	● NUM_6: rotación hacia la Derecha.

	● Ctrl + NUM_6: desplazarse hacia la Derecha.

	● NUM_2: rotación hacia abajo.

	● Ctrl + NUM_2: desplazarse hacia abajo.

3.	 Estas teclas son las que te proporcionaran una gran ayuda:

	● NUM_1: visión Frontal.

	● Ctrl + NUM_1: visión Trasera.

	● NUM_3: visón Derecha.

	● Ctrl + NUM_3: visión Izquierda.

	● NUM_7: visión Superior.

	● Ctrl + NUM_7: visión Inferior.

4.	 Las teclas de suma y resta te servirán para hacer zoom en el visor.

1.3.7	 Funciones Básicas

Para finalizar necesitarás hacerte con unas funciones básicas para poder 
empezar a trabajar con Blender.

1.3.7.1	 GUARDAR Y CARGAR ARCHIVOS 

Blender usa el formato de archivo .blend para salvar casi todo: objetos, 
escenas, texturas e incluso todas tus opciones de la ventana de preferencias del 
usuario.

	] Cargar archivos: presionando F1 puedes acceder a la ventana de selección 
de archivos. Para cargar un archivo en el panel de la izquierda puedes 
seleccionar la carpeta o directorio que desees con BIR y presionando 
ENTER, o simplemente realiza doble clic en él con el BIR. También 
puedes arrastrar el archivo de la carpeta directamente a Blender.
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Figura 1.36. Panel para grabar o cargar

	] Guardar: presiona F2, volverás otra vez a la ventana de selección de 
archivos. Haz clic en la ventana de edición inferior para escribir un 
nombre de archivo. La extensión “.blend,” es añadida automáticamente. 
Después presiona ENTER para guardar el archivo. Si ya existe un archivo 
con el mismo nombre, el programa te preguntará si deseas substituir el 
archivo con el mismo nombre tendrás que confirmar en el caso de que 
quieras guardar con el mismo nombre o renombrar el archivo. 

1.3.7.2	 HACER UN RENDER

Esta función se explica con más detalle en otros capítulos pero para que 
puedas ver como se hace, puedes pulsar F12, la ventana activa se convierte en una 
ventana de render. Para volver a la ventana anterior pulse ESC.

1.3.7.3	 PREFERENCIAS DE USUARIO

Preferencias incluyen detalles de la interfaz del usuario, y propiedades del 
sistema como el ratón, las fuentes y los lenguajes. Puedes acceder o bien pulsando 
CTRL+ALT+U o bien accediendo a la cabecera principal que encontrará arriba en 
la interfaz y siguiendo File > User Preferences.
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Figura 1.37. Panel para grabar o cargar

	] Interface: estas opciones configuran parte de los elementos de la interfaz 
como el espacio entre las rejas de la ventana 3D, el tamaño del eje de 
coordenadas. 

	] Editing: te permite especificar los detalles del funcionamiento de ciertos 
comandos de edición como por ejemplo aspectos del Grease Pensil, 
cuando te equivoques el número de veces que puede retroceder, aspectos 
de los fotogramas etc...

	] Input: en este apartado encontrarás opciones de cómo debe reaccionar 
la interfaz a las acciones del usuario, como qué método de rotación 
debe usarse en las vistas 3D. Si vienes de otro software como 3Dsmax y 
Maya puedes configurar Blender para que este se comporte como estos 
programas. (Lo desaconsejo).

	] Addons: Un apartado muy interesante, puedes encontrar pequeños 
programas que te pueden facilitar algunas funciones de Blender. Son 
aplicaciones que puedes activar o desactivar según te interese. Muchas 
de estas aplicaciones han sido creadas por usuarios de la comunidad.

	] Temas: Blender permite la utilización de Temas para definir colores 
personalizados para la interfaz. Puedes crear y manejar temas desde aquí.
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	] File: puedes configurar Guardar Automáticamente para tener una copia 
de emergencia en caso de que algo vaya mal. Estos archivos se llamarán 
Nombre.blend1, Nombre.blend2, etc.

	] System: este apartado dispone de la configuración de los gráficos, la 
salida de audio y configuración de su sistema respecto el programa. 
Aquí puedes también configurar el esquema de luces para los modos de 
dibujado Solido y Sombreado.

1.4	 PROYECTO CAPÍTULO

1.4.1	 Conociendo Blender

En este capítulo no se va a realizar ningún proyecto en sí, pero sí que se va 
a proponer una serie de actividades para que puedas practicar lo aprendido hasta 
ahora. Intenta realizar las actividades sin ver el video, si tiene dificultades mira el 
video e inténtelo después solo.

	] Tienes que visitar la página web de www.blender.org y descargar el 
programa en el caso de que no lo hayas hecho todavía.

	] Instala el programa en tu ordenador y realiza las siguientes actividades.
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	] Manipula las ventanas y aprende a moverte en el espacio 3D utilizando 
tanto el ratón como el teclado numérico.

	] Cuando hayas adquirido un poco de soltura y te encuentres cómodo 
intenta guardar un archivo con una interfaz creada por ti con los tipos de 
ventana que tú quieras.

	L NOTA
Recuerda que este libro está dirigido no solo a las personas que quieran iniciarse a 
Blender si no también a las personas que quieran aprender 3D desde cero.


